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Hang Loose Convolver is VST and ASIO compatible.

r8brain pro sample rate converter designed by Aleksey Vaneev of Voxengo

https://github.com/avaneev/r8brain-free-src
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Why Hang Loose Convolver

Music lovers: a highly refined listening experience! Music geeks: A/B compare eq filters in real-
time!

One purpose of Hang Loose Convolver is to determine a preference for one eq filter over another while
listening to music using speakers or headphones.

If you are eq’ing loudspeakers and headphones, how do you know if the eq sounds better or worse than
with no eq? How do you know if Filter A sounds better or worse than Filter B? There is science behind how
this works which is designed into HLConvolver.

Hang Loose is designed to switch between level-matched "eq" filters in real-time with no audible gaps or
digital artifacts regardless if the filters are linear phase, minimum phase, or mixed phase.

Fast and seamless filter switching

Fast and seamless switching of filters satisfies the brains processing of short term audio memory called
echoic memory.

· "Echoic memory is the sensory memory that register specific auditory information (sounds). Once an
auditory stimulus is heard, it is stored in memory so that it can be processed and understood." 

Summarizing the science, echoic memory lasts 1 to 10 seconds. This is "why" the requirement for fast and
seamless switching between filters (and bypass) so one can focus on the full echoic memory during the
first 10 seconds of a filter switch (or bypass) to determine a preference. Note it is not the rapid switching
between filters (and bypass) that allows one to tune into the difference. It is the transition or instant switch
that our ears tune into both tonal and timing changes. Timing changes can range from the time alignment of
speakers or individual drivers to excess phase correction of the room at low frequencies.

Level matched filters

Hang Loose is designed so that each Filterbank has its own gain slider to adjust the gain of the filter. This
allows one to "level match" each filter to another (and bypass) either by ear or instrumentation assisted
using pink noise, a sound level meter or HLC's built-in metering. Summarizing the science, if one level is
higher than the other, almost always the higher level "wins" as "better" sounding. This is due to our ears'
nonlinear frequency response often referred to the Fletcher Munson (now ISO 226) equal loudness contour
curves.

Simply put:
· at lower listening volumes mid-range frequencies sound more prominent, while the low and high

frequency ranges seem comparatively quieter.
· at higher listening volumes the lows and highs sound more prominent while the mid-range seems

comparatively quieter.

Therefore, our ears interpret louder sound to have a fuller bass and more clarity on the top end.
Conversely, we perceive quieter sounds to be thinner and duller. Even an increase of 1 dB SPL can create
the illusion of a "better" sound.

This is "why" filter level matching is critical in determining one's filter preference.

Additional features

The "Autogain" feature normalizes the gain of any FIR filter to 1.0 and is automatically applied to the filter's
gain slider as a starting point for level matching filters. Depending on the frequency response of the FIR eq
a small amount of gain trimming may be required due to how our ears/brain perceive loudness. If gain

https://en.wikipedia.org/wiki/Echoic_memory
https://en.wikipedia.org/wiki/Equal-loudness_contour
https://en.wikipedia.org/wiki/Equal-loudness_contour
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trimming is required, then one can play a Pink Noise .wav file that was installed during the installation
process. Switching between filters and/or bypass while watching HLC meters, one can dial it in so the
levels match. Or, use a sound level meter while playing the Pink Noise. More often than not, the AutoGain
is good enough to hear the difference between filters without any further gain trimming. If gain trimming is
required, then it is usually by a small amount.

The "Master Trim" level controls the overall gain of the convolver. The idea is to "level match" the gain of
the filters with the "bypass" level. Using the "Output Level" meters, one can ensure no clipping is occurring
in the convolver. If clipping occurs, one can reduce the master trim level so the bypass level goes down
and one can increase the filter gain slider level so that no clipping occurs, but now the filter is level matched
to the bypass level.

HLC implements the industry standard convolver "config" file specification. Most features of the spec have
been implemented, including:
· input and output delays with 0.1ms resolution.
· input and output channel weights.
· summing input channels to a single output path - typically used for cross-talk cancellation filters.
· both absolute and relative file paths to the filters are supported.
· supports mono and stereo .wav files 32 bit single precision floating point format. 
· If the host sample rate changes, HLC will look for a matching .cfg filter to load automatically.

Standalone application and plugin modes of operation on multiple operation systems allows Hang Loose to
operate on system wide audio and application specific audio across the broadest range of audio sources
possible.

Conclusion

Hang Loose Convolver allows one to compare filters in a scientific way without having to mess with the
mechanics of level matching filters and seamless filter switching. It is easy to operate on the widest range
of audio sources which allows you to "hang loose" and focus on which filter you prefer.

Please take the time to read the operations guide to get the most value out of Hang Loose. I hope you
enjoy using this convolver.

Kind regards,
Mitch

http://convolver.sourceforge.net/config.html
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Why Hang Loose Host

Hang Loose Host (HLHost) is a simple application that "hosts" plugins. It is designed to be flexible in adding
any plugin (e.g. VST3) to the canvas, configure the number of channels, if required, and provides an easy
way to "wire up" plugin "pins" to provide any type of signal flow and routing.

For example,

In this stereo example on a Raspberry Pi5, HLHost has 5 plugins added:

1. A simple VST3 AudioFilePlayer that plays music.

2. Hang Loose Convolver plugin that is a convolution engine for comparing level matched room or
headphone correction filters in real-time

3. Room Shaper plugin that analyzes the rooms low frequency decay and ensures the decay time is the
same across low frequencies.

4. x-Talk Shaper plugin that provides cross talk cancellation.

5. LSP Loudness Control that allows one to apply industry standard loudness compensation based on a
calibrated listening level.

HLHost's Audio Settings dialog makes it simple to choose inputs and outputs, set sample rate, and buffer
size:
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In this example, HLHost is configured for 16 channels of digital I/O using a virtual audio loopback driver on
the Mac called BlackHole, and the output is going to a 16 channel Merging Technologies DAC using
Merging's Ravenna AOIP virtual audio driver.

Virtually any custom plugin scenario can be easily configured in HLHost.

See adding plugins to Hang Loose Host.
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Software and System Requiements

Operation Systems:

Windows 10, 11 or greater 64 bit.
MacOS 10.15 or greater 64 bit. Runs on both Apple Silicon and Intel-based Mac computers.
Linux Ubuntu 20.05.5 LTS or greater 64bit.
Raspberry Pi4 64 Bit OS Debian version 11 (bullseye) or greater.

If using HLC's web UI, any modern browser will work.

What's installed:

Both the Windows and Mac installer contains:

1. HLHost.exe standalone host application that hosts any plugin, including HLC plugin.
2. HLConvolver.exe is a standalone convolver application with both a native and web interface. Can run

headless.
3. HLConvolver.vst3 plugin.
4. HLConvolver.aaxplugin
5. HLConvolver.component Audio Unit (AU) plugin (Mac only).
6. Dirac Pulse 441.wav stereo convolution filter for testing the Autogain feature.
7. Pink_min_20_dBFS_RMS_uncor_st_441.wav file to assist in level matching filters to bypass level.

Depending on the OS platform, the .exe and plugin(s) can be run on the same computer or on different
computers. The license key allows up to 6 activation's.

On Mac, the installation of the plugins are installed at: 
· ~/Library/Audio/Plug-Ins/VST3
· ~/Library/Audio/Plug-Ins/Components
· ~/Library/Application Support/Avid/Audio/Plug-Ins

Both HLHost.exe and HLConvolver.exe are installed at:
· ~/Applications

On Windows, the installation of the plugins are installed at:
· C::\Program Files\Common Files\VST3
· C:\Program Files\Common Files\Avid\Audio\Plug-Ins

The exe and rest of the files are installed at:
· C:\Program Files\Accurate Sound

On Linux and Raspberry Pi, 

Plugin Locations:

Referring to HLHost application, when plugins are installed, these are the "default" directories that the
plugin manufacturer will install the plugins into. HLHost already has these locations built into the Scan dialog
so you don't need to enter these. However, you can customize and add specific locations as required.

On Mac, the installation of the plugins are installed:
· ~/Library/Audio/Plug-Ins/VST3
· ~/Library/Audio/Plug-Ins/Components 

On Windows:
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· C::\Program Files\Common Files\VST3

On Linux and Raspberry Pi:
· ~/.vst3/
· /usr/lib/vst3/
· /usr/local/lib/vst3/

For LADSPA plugins on Linux:
· /usr/lib/ladspa
· /usr/local/lib/ladspa
· ~/.ladspa

For LV2 plugins on Linux:
· ~/.lv2
· /usr/lib/lv2
· /usr/loca/lib/lv2
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Performance Profiling

Performance:

HLC has been extensively performance profiled using Melatonin Perfetto on Mac, Windows, Linux Ubuntu,
and Raspberry Pi OS.

The result of this performance testing has led to two optimizations:
1. Profiling the performance with/without instant filterbank switching has led to a significant performance

increase that is now user selectable.
2. Profiling the performance of different FFT libraries has led to significant performance increases on

each OS platform. In most cases, a 50% performance increase over the "default" FFT library used for
each platform OS.

How does that translate into real world usage? Here are two examples:

HLHost using 5 plugins running on a Raspberry Pi5:

In this stereo example on a Raspebrry Pi5, HLHost has 5 plugins added:

1. A simple VST3 AudioFilePlayer that plays music.

2. Hang Loose Convolver plugin that is a convolution engine for comparing level matched room or
headphone correction filters in real-time

3. Room Shaper plugin that analyzes the rooms low frequency decay and ensures the decay time is the
same across low frequencies.

4. x-Talk Shaper plugin that provides cross talk cancellation.

5. LSP Loudness Control that allows one to apply industry standard loudness compensation based on a
calibrated listening level.

HLC is loaded with 65,536 tap FIR filters at 96 kHz sample rate x 6 Filterbanks - i.e. all 6 Filterbanks are
processing.

https://github.com/sudara/melatonin_perfetto
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Room Shaper plugin has imported 262,144 tap FIR filters x 2 and set to maximum processing,

Sounds crystal clear with no dropouts or static. Given that a RaspberryPi5 can handle complex DSP
scenarios from a performance perspective means virtually any computer will easily do the job.

2nd example - running as a plugin on an inexpensive Windows PC:

As one increases the number of convolution channels, higher sample rates, and longer filter lengths, the
processor has more work to do. However, even a small $200 Windows PC can process all 6 filterbanks
loaded with 7.1 channel, 96 kHz 131,071 tap filters hosted in JRiver Media Center as an example. That's
48 convolvers running on a low power PC. See article, "Accurate Sound's Hang Loose Convolver
Multichannel on low power Mini PC."

http://archimago.blogspot.com/2022/11/accurate-sounds-hang-loose-convolver.html
http://archimago.blogspot.com/2022/11/accurate-sounds-hang-loose-convolver.html
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Activating Hang Loose DSP Suite

Hang Loose DSP Suite

(HLSDPSuite) can be downloaded for a 14 day trial or a perpetual license key can be purchased. 

Once ordered, an email with download links and license key will be sent.

Activation can be performed in HLConvolver as a plugin, as a standalone application using the native
interface, web interface, or HLC web API or in HLHost application.

Please note that an internet connection is required to activate HLC, but can be disconnected after
activation. Note a filter must be loaded in order to pass audio. Once can use the Dirac pulse.wav file that
comes with the installation and load as a "dummy" filter that does not alter the frequency or phase
response to confirm operation.

https://accuratesound.ca/hang-loose-convolver-hlc/
https://accuratesound.ca/product/hang-loose-convolver-14-day-free-trial/
https://accuratesound.ca/product/hang-loose-convolver/
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HLC plugin
Plugin mode:

If you have installed HLConvolver as a plugin in a different Host application than HLHost, then simply launch
the plugin GUI from the Host application and click on the Activate button:

Enter your license key and click Activate. The activate button should go away and now you are ready to
load filters.

If the activate button does not go away, try closing and reopening the editor window. If that does not work,
try closing the Host application and relaunch. If that still does not work, then an error message will have
been written out to a log file. Here are the locations of the log file, please zip up and send to Accurate
Sound.
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HLC web interface
Web interface mode:

Hang Loose Convolver application and plugin can be activated via a web interface using a browser.

The first section covers activating HLC in standalone mode and the second section, plugin mode.

Firewall security

NOTE: Both HLC application and plugin contain a web server for the REST API's. When HLC is first
launched as a standalone app or plugin, and depending on the platform OS you are running on, a firewall
popup dialog may appear.

You only have to grant access once.

This example is on Windows launching HLC application:

Click on Allow access via Private network

In the case of running HLC as a plugin, you may run into the Allow access during the installation of the
plugin like this example using JRiver to add the HLC plugin:
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One only needs to select private networks. Click Allow.

The host application launching the plugin may also ask for permission:
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Again, click on Allow access to private networks.

NOTE: This should only happen during the 1st installation and 1st run of HLC application and plugin. Once
allowed, there should be no more security firewall warnings.
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Standalone mode

First, a local IP address is required on the computer that is running the application and/or plugin.

Note that HLC application can also run headless and be accessed via the web interface.

From a command line interface, the following commands can be issued to return the IP address:

On Windows:
ipconfig /all

On Mac:
ipconfig getifaddr en0 (sometimes it is en1)

On Linux and Raspberry Pi:
ip a

Once you have the IP address, the default port for the web server is: 8081 and is configurable.

To see how to set the standalone port, other than default, launch HLConvolver.exe from the command line
with the --help option:

Using the default port for HLConvolver.exe and the IP address on the computer with HLConvolver.exe
running (in GUI or headless mode). In GUI mode, double click HLConvolver.exe. For headless operation,
from the command line interface:

Windows: HLConvolver.exe --headless

On Mac: open hlconvolver.app --args --headless

On Linux and Raspberry Pi: ./HLConvolver.exe --headless

Once HLC is running use the web browser to access the interface:
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In this example, HLConvolver is running on IP address: http://192.168.1.66:8081/

Enter in your license key - make sure there are no spaces before the key:
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After clicking activate, you should see the following screen for the standalone version of HLC:
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The standalone version also includes the Audio Settings dialog which allows you to interact with your input
and output devices, set sample rate and buffer size.
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Now you are ready to load filters.

NOTE: If there is an error it will have been written out to a log file. Here are the locations of the log file,
please zip up and send to Accurate Sound.
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Plugin mode

In plugin mode, HLC is running as a plugin in HLHost, a DAW, JRiver, Audirvana, Foobar2000, or any
software that can host a plugin.

Please note that the s/w hosting the plugin needs to be running before the web interface can work.

To get the IP address on the computer running HLC as a plugin, launch a command line interface and use
the following commands can be issued to return the IP address:

On Windows:
ipconfig /all

On Mac:
ipconfig getifaddr en0 (sometimes it is en1)

On Linux and Raspberry Pi:
ip a

In the example below, HLC is running in an instance of JRiver and the IP address is:
http://192.168.1.66:8080/

Copy and paste your license key - make sure there are no blank spaces before or after the license key.

Once entered, click on the Activate button. The interface should now look like this:
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Now you are ready to load filters.

NOTE: If there is an error it will have been written out to a log file. Here are the locations of the log file,
please zip up and send to Accurate Sound.
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HLC application
Standalone mode:

HLC can run as a standalone application. It can be run with its native interface or run headless, using a
web interface.

One can double click on HLConvolver.exe or run it from the command line interface. Through the command
line interface, one can pass it arguments to run in headless mode or configure the port address. Typle in
HLConvolver.exe --help to see the options.

Double clicking on the HLConvolver.exe:

Enter your license key and click Activate. The activate button should go away and now you are ready to
load filters.

If the activate button does not go away, try closing and reopening the editor window. If that does not work,
try closing the Host application and relaunch. If that still does not work, then an error message will have
been written out to a log file. Here are the locations of the log file, please zip up and send to Accurate
Sound.
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HLHost application
HLHost application mode:

HLHost which is a simple Host application to run any plugin including HLC plugin. With a virtual or h/w
loopback driver, one is able to send application specific or system wide audio through HLConvolver (and
any other plugin).

Launch HLHost application:

From the Options Menu, select Activate...
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Cut n paste your license key into the text box and click Activate:

A dialog should confirm HLHost has been activated successfully:
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If there is an error, it will be reported in a dialog:
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Please send the status code to Accurate Sound along with the log files.

Note there are additional guides for configuring and activating HLConvolver and HLHost for Windows, Mac,
Linux and Raspberry Pi.
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Additional Installation Guides

Linux Ubuntu
Please note that the following package dependencies need to be installed before running HLC:

sudo apt update
sudo apt install libasound2-dev libjack-jackd2-dev \
    ladspa-sdk \
    libcurl4-openssl-dev  \
    libfreetype-dev libfontconfig1-dev \
    libx11-dev libxcomposite-dev libxcursor-dev libxext-dev libxinerama-dev libxrandr-dev libxrender-dev \
    libwebkit2gtk-4.1-dev \
    libglu1-mesa-dev mesa-common-dev

While the installation of HLC on Ubuntu is similar to Windows and Mac, there are a few items to be aware
of, mostly where the VST3 is to be located.

HLConvolver.vst3 should be placed in one of the following directories:

· /home/yourusername/.vst3
· /usr/lib/vst3
· /usr/local/lib/vst3

Typically, it is the easiest to place HLConvolver.vst3 in the /home/yourusername/.vst3 directory:

Note you many need to select "Show Hidden Files" for the .vst3 directory to appear.

If you are using music player software that allows for VST3 "plugins" you are ready to go. HLConvolver just
needs to be Activated when launched in another host.

To run HLConvolver.exe simple double click on the executable or from a command line interface, type in
HLConvolver.exe

NOTE: you can also use the HLConvolver.exe --help argument to display options like running in headless
mode or changing the port address.

NOTE: that for HLConvolver.exe and HLHost.exe you may need to give the executable permissions after
being downloaded from the internet:
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Make sure you have permissions to run the application and that it is Executable as Program.

If you wish to run HLC and additional plugins, copy HLHost to a location on your drive. Then double click
HLHost to launch:
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From the Options menu, select: "Edit the list of Available Plug-ins...

One should now see a separate dialog Window:
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Click on the Options... button and select "Scan for new or updated VST3 plug-ins." The following dialog
should appear:
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Click on Scan. The result is HLConvolver should be in the list of available plugins:
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Close the Window.

Right click anywhere on the canvas and add HLConvolver:
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Screen should look like:
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Double click on HLConvolver. Note: right clicking on HLConvolver and selecting "Configure Audio I/O" will
allow on to configure multichannel operation.
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Click on the Activate button which should bring up a dialog box. Cut n paste your license key into the box
and click Activate.

The convolver should now be activated and a filter can be loaded:
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Don't forget in HLHost to click on the File menu and select save to save your filtergraph (i.e. state) to your
hard disk.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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Raspberry Pi
Please note that the following package dependencies need to be installed before running HLC:

sudo apt update
sudo apt install libasound2-dev libjack-jackd2-dev \
    ladspa-sdk \
    libcurl4-openssl-dev  \
    libfreetype-dev libfontconfig1-dev \
    libx11-dev libxcomposite-dev libxcursor-dev libxext-dev libxinerama-dev libxrandr-dev libxrender-dev \
    libwebkit2gtk-4.1-dev \
    libglu1-mesa-dev mesa-common-dev

While the installation of HLC on Unbuntu is similar to Windows and Mac, there are a few items to be aware
of, mostly where the VST3 is to be located.

HLConvolver.vst3 should be placed in one of the following directories:

· /home/yourusername/.vst3
· /usr/lib/vst3
· /usr/local/lib/vst3

Typically, it is the easiest to place HLConvolver.vst3 in the /home/yourusername/.vst3 directory:

You may have to click on the View Menu and select Show Hidden Items.

If you are using music player software that allows for VST3 "plugins" you are ready to go.HLConvolver just
needs to be Activated when launched in another host.

To run HLConvolver.exe simple double click on the executable or from a command line interface, type in
HLConvolver.exe
You can also use the HLConvolver.exe --help argument to display options like running in headless mode or
changing the port address:
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NOTE: that for HLConvolver.exe and HLHost.exe you may need to give the executable permissions after
being downloaded from the internet:

HLConvolver.exe is an executable and should have the following permissions that you may have to set
when downloading an executable from the internet:
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Make sure that the Execute is set to Anyone or your name.

If you wish to run HLC and additional plugins, copy HLHost to a location on your drive. Then double click
HLHost to launch:

One way to launch the host is to use the Run command. For example, I have HLHost application in my
directory:
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Should look something like this:

From the Options menu, select: "Edit the list of Available Plug-ins...
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One should now see a separate dialog Window:
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Click on the Options... button and select "Scan for new or updated VST3 plug-ins." The following dialog
should appear:
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Click on Scan. The result is HLConvolver should be in the list of available plugins:
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Close the Window.

Right click anywhere on the canvas and add HLConvolver:
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Screen now should look like:
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Double click on HLConvolver. Note: right clicking on HLConvolver and selecting "Configure Audio I/O" will
allow on to configure multichannel operation.
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Click on the Activate button which should bring up a dialog box. Cut n paste your license key into the box
and click Activate.

The convolver should now be activated and a filter can be loaded:
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Don't forget in HLHost to click on the File menu and select save to save your filtergraph (i.e. state) to your
hard disk.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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JRiver and VST3 buffer size
While this example is using Windows, it is the same on Mac and Linux.

In JRiver select Tools->Options->Settings->DSP and output format...

Click on "Manage Plug-ins...

And select "Add JRiver, VST or Winamp Plug-in...

A permission Dialog should come up:
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Click on Yes.

Navigate if necessary to where the plugin has been installed which is:

C:\Program Files\Common Files\VST3

Select HLCovnolver.vst3

Important note: On Windows, newer versions of HLConvolver (version 1.2.2 and greater) now "bundle"
the VTS3, which is essentially a folder in which one needs to navigate a few levels down in order to load
the VST3 file. Note the new path: C:\Program Files\Common
Files\VST3\HLConvolver.vst3\Contents\x86_64-win\HLConvolver.vst3
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Now HLConvolver should be in the DSP left hand pane. Select HLConvolver:
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If HLC has not been activated, click on the Activate button:
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Cut n paste the license key and then click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate.

Now that HLC has been activated, one can load a filter into the Filterbank by clicking on the Magnifying
glass icon. Navigate to where you have a filter and load it.
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In the example above a Dirac pulse stereo.wav file has been loaded. The Dirac pulse is a test filter to
ensure everything is working. Once can verify by playing music and then opening up the convolver again:
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Note there is one last JRiver setting that requires adjustment. VST3 buffer size is adjustable in JRiver:
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256 samples is usually not enough and would recommend 1024 or 2048 samples as the VST3 buffer size.
If you are using a low power PC, with higher sample rate filters, and hear static or drop outs, continue to
increase the buffer size to 4096 or even 8192 samples. Note that you must restart JRiver to in order for
the changes to take effect.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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Pro Tools
There are no special instructions for Pro Tools. Once the installer has run, HLConvolver.aaxplugin will be
located:

Mac: ~/Library/Application Support/Avid/Audio/Plug-Ins
Windows: C:\Program Files\Common Files\Avid\Audio\Plug-Ins

Simply start up Pro Tools and HLConvolver should be loaded as an available plugin.

On Windows:

On Mac:
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Quick Start for Standalone Operation

This section will get you up and running as quickly as possible.

Unless you are using the VST3 or AU plugin directly in a music application like JRiver or Audirvana or a
DAW like Reaper or Ableton, then it is likely you will want standalone operation. There are two ways to
accomplish this:

1. HLConvolver.exe - can run using its native interface or run headless. In either case, can be accessed
via web browser interface - use this for standalone convolution.

2. HLHost.exe - can host any plugin, including HLC plugin - use this if you wish to run additional plugins.

If you are using a VST3 or AU directly in a Host application, see Quick Start for VST3 and AU Plugins.

One-time Loopback Installation
In a typical application configuration, HLHost and HLConvolver application requires a virtual audio loopback
driver to be installed. If your audio interface supports onboard digital loopback, then a virtual loopback
driver may not be required. See  h/w loopback configuration.

There are several 3rd parties that offer virtual audio loopback drivers ranging from donationware to
commercial products.The following products have been tested with HLHost:

· VB-Virtual Audio Cable - first download on the page, easy install and should work out of the box
without any further adjustments.

· VB-Matrix (including ASIO) - Aggregate audio devices on Windows, complete with clock
synchronization and virtual audio networking with multichannel support.

· LoopBeAudio - simple, easy to configure with foolproof method of ensuring I/O sample rate and bit
depths are the same. Widows Audio driver support 24 channels of digital I/O.

· Virtual Audio Cable (VAC) - fully featured.

· BlackHole zero latency virtual audio loopback driver for Mac.

· ALSALoop and PulseAudio Loopback for Linux and RPi.

· pipewire and pipewire loopback from Linux and RPi.

· Merging Virtual Audio Driver (VAD) for audio networks.

· Dante Virtual Audio Driver for audio networks.

Each of the virtual drivers above have been verified to work reliably with HLHost. If clock synchronization
becomes an issue, there are solutions. See Clock Synchronization.

Important note: If you are running into an issue where there is no sound, the most likely cause is that the
virtual audio loopback has not been configured correctly. It is impossible to write step by step instructions
for every possible setup and configuration, on four different platforms. Further, rather than writing pages of
instructions, this type of "system" configuration is best described by the video, The Easy Way to add DSP
"Plugins" to any Music Application.

https://vb-audio.com/Cable/
https://vb-audio.com/Matrix/
https://www.nerds.de/en/loopbeaudio.html
https://vac.muzychenko.net/en/
https://github.com/ExistentialAudio/BlackHole
https://github.com/TheSalarKhan/Linux-Audio-Loopback-Device/blob/master/README.md
https://wiki.ubuntu.com/record_system_sound
https://docs.pipewire.org/page_overview.html
https://docs.pipewire.org/page_module_loopback.html
https://www.merging.com/products/aes67-vad
https://www.audinate.com/products/software/dante-virtual-soundcard
https://youtu.be/0MkQUf92D20?si=C_q9wGUnh2uRG77p
https://youtu.be/0MkQUf92D20?si=C_q9wGUnh2uRG77p
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Each virtual audio driver vendor has their own install guides, trouble shooting tips, and forums to support
their products. While Accurate Sound can provide a small amount of troubleshooting, each vendor provides
their own product support.

The virtual audio drivers are designed to "loopback" the output of one app into the input of another app.
The basic audio path one is trying to achieve is:

Music application and/or system wide audio output -> virtual audio input -> virtual audio output -> HLHost
input -> DSP plugins -> HLHost output -> DAC.

Using VB- Audio Virtual Cable as one example, and looking at HLHost (or HLCovnolver.exe) Audio Settings
on Windows, note that the Input is the Cable Output. A common misconfiguration is selecting Cable Input
as the Input. The audio settings below are correct where an audio application or system wide audio is
going to the input of VB cable input, the cable output is selected as the input. The output is going to a DAC,
and in this example, a Topping E30:

https://youtu.be/0MkQUf92D20?si=C_q9wGUnh2uRG77p


Hang Loose DSP Suite Operations Guide

65 / 197

Important note: if you cannot select an input, the most likely cause is that HLHost or HLConvolver.exe has
not been given microphone access permissions by the operation system. Please see the  troubleshooting
section for other common configuration issues with virtual audio drivers.
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Hardware Loopback

Check to see if your digital audio interface can support on-board digital loopback. This is typical for "Pro"
AD/DA converters.

Windows:

Here is an example using a Motu mk5 Ultralite using ASIO loopback on Windows:

In this example, using ASIO on Windows, the music application or system wide audio is being output to
channels 7 and 8 in Windows audio. In the Motu device, channels 7 and 8 are internally routed to loopback
channels 1 and 2 which are input to HLHost. After DSP processing, the output is channel 1 and 2 Main Out.

Another example. 

Mac:

In this example, Spotify is being used as the music app, but it can be any app or system wide audio on the
Mac. In many cases, music apps on Mac typically output to channels 1+2. So in order for h/w loopback to
work, channels 1&2 need to be assigned as the loopback channels in the audio interface that is being
used. In this case, a Motu mk5 is being used, so in the CueMix app, change the default loopback location
from channel 9+10 to channel 1+2:

https://audiophilestyle.com/forums/topic/62919-article-introducing-hang-loose-convolver-from-accurate-sound/page/3/#comment-1156584
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Now let's look at how this is setup:

Note that in the Audio Midi Setup, the Motu mk5 is set as both the input and output device. Next, ensure
that the Mac Sound has the Motu mk5 selected as output.

Next in CueMix, in the case of this setup, headphones monitoring on output 3&4 which corresponds to
HLHost having enabled output 3+4, but in the case of a biamp or triamp setup, one can enable as many
outputs as required and configure HLC for the requisite number of channels.

In this example, Spotify is being used as the music app which outputs to 1+2 which is then loopback into
HLHost, through HLC and output to channels 3+4 which using headphones to monitor the output. However,
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it can be any app or system wide audio.

Note:

Typically, "pro" interfaces come with Analog to Digital Converters (ADC) so that analog sources (e.g.
turntable, reel to reel, etc.) can be connected and run though DSP. Additionally, a microphone preamp are
also available which makes it easy to connect a calibrated analog measurement microphone. This allows
the interface to also be used for taking acoustic measurements for Digital Room Correction (DRC)
purposes.This avoids the "two clock" scenario with USB microphones and the subsequent timing errors that
are introduced.

Two different h/w digital I/O devices:

Another form of hardware "routing" is using two different hardware audio devices.

In this example, HLHost is running under Windows. The input device is an ESI U24XL USB device that has
S/PDIF digital input where an external CD player, SmartTV, or gaming console can be input to HLHost for
DSP. The digital output is going to a different device, in this case a Topping E30 USB DAC:

In the case of the ESI U24XL device, it also has an Analog to Digital Converter (ADC) built in so analog
sources like turntables, etc., can be routed through DSP.
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Configuring HLC application
HLC application comes with it's own Audio Settings dialog and ability to save/restore state. It is the
simplest and quickest way to get convolution running for any given room correction and/or headphone filter
setup in a reliable manner on any supported platform.

The application can run in native GUI mode or headless mode.

Both the HLC application and plugin can be accessed separately via a web interface using a browser.

The idea is that one can be sitting in the listening position and with a phone or tablet, can load filters and
instantly switch level matched filter from the comfort of ones listening chair or couch with minimal effort.

The main difference is that HLC application includes an Audio Settings dialog and HLC plugin mode does
not.

One can load a single stereo.wav filter, a .zip file containing one to many stereo.wav filters, a cfg
configuration file that adheres to the industry standard convolver "config" file specification.

Native interface mode

Once the software has been activated, the application runs on Mac, Windows, Linux and Raspberry Pi and
behaves in the same way across all platforms. 

Double clicking the application icon which launch HLC application in native GUI mode. 

In this example, running on Windows:

http://convolver.sourceforge.net/config.html
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Note that the default setting is the input is muted. This can be toggled off and on.

Clicking on either the Settings... button the top right or clicking into the Options button and selecting Audio
Settings will bring up the same Audio Settings Dialog:
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Here one can select the audio device type (e.g. on Windows, ASIO, WASAPI (exclusive and shared
mode), Windows low latency mode, and Direct Sound. Depending on which platform the HLC application is
running on will display all available device types in the drop down box.

The active input and output channels are read only in the user interface. Meaning one cannot activate or
deactivate channels. Depending on whether a stereo audio device or multichannel audio interface (or virtual
audio driver), HLC will automatically detect the maximum number of input and output channels supported
and will set the active inputs and outputs to the maximum number of channels supported. 

NOTE: HLC application selects the maximum channels available (if different count for either input or output,
the maximum number is selected). There is a 1:1 channel mapping from input to output. If you need to
select or deselect any of the active input and/or output channels, and/or provide a different input and/output
routing, then use HLHost.

All available sample rates and buffer sizes will displayed for the selected audio device type.

NOTE: Generally speaking, the more filterbanks being used, higher sample rates, and longer tap filters will
require a larger buffer size. However, this is not true in all cases. If you hear dropouts or static or the
music appears to slow down in pitch, increase the buffer size. If that does not help, try shorter buffer sizes.
If using a virtual audio driver, check to see if that buffer size can also be changed.

HLC application will remember the filters loaded and any of the gain parameters that have been adjusted
upon close (X) of the application. When the application is relaunched again, all of the settings, including the
audio device selected, sample rate, buffer size will be restored.
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NOTE: If the preferred audio device is not available (i.e. turned off or unplugged from the computer) then
HLC application will show the next available device that is ready. To ensure that the preferred device is
selected, make sure it is available and ready before launching HLC application.

Now one can load filters.

Saving and Restoring State

Just like HLHost, HLC application can save and restore its application state in a (.filtergraph) file. For
example, one can load HLC filterbanks with just linear phase FIR filters used for critical listening to music
with speakers and/or headphones. That can be saved.

Under the Options menu, select Save Current State...

Select a location, for example on Windows under Documents in a folder called Filterbank Presets:
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Then the filterbanks can be loaded with just minimum phase FIR filters for movie watching of gaming over
speakers and/or headphones. That state can be saved. Then depending if listening to music and comparing
filters or watching a movie or playing a game where lipsync or any perceived audio lag is a no go, the
correct preset can be loaded simply by selecting Options - Load a saved state:
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Once can select either filtergraph depending on the usage scenario.
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Headless mode

HLC application can run headless on Mac, Windows, Linux, or Raspberry Pi OS.

From a command line interface, navigate to the location where HLC application is installed.

Step 1 - Get IP Address

First we want to get the IP address on the computer that HLC application will be running on. This is so
when HLC application is running headless, the IP address is used to access the running instance using web
browser:

From a command line interface, the following commands can be issued to return the IP address:

On Windows:
ipconfig /all

On Mac:
ipconfig getifaddr en0 (sometimes it is en1)

On Linux and Raspberry Pi:
ip a

Step 2 - Launch HLC application headless

Once you have the IP address, the default port is: 8081 and is configurable (use --help argument). Note
the IP address.

From the command line interface, navigate to the directory where HLC application is installed. Then from
the command line, launch HLC headless:

Windows: HLConvolver.exe --headless

On Mac: open hlconvolver.app --args --headless

On Linux and Raspberry Pi: ./HLConvolver.exe --headless

Step 3 - Launch a web browser and type or paste in the IP address with Port 8081 from above.

Proceed to activate the software or if already activated, the next section shows how to use the web
interface.
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Web interface

Standalone mode

Launch HLC application in native GUI mode or headless mode.

Obtain the IP address on the computer that is running the HLC application. Note: running on "default" Port
8081 unless one has changed the Port address.

Go to the IP address using a browser:
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Audio Settings

Step 1 - Adjust Audio Settings:

Typically, the first step is to adjust the Audio Settings for your particular usage scenario(s).

In the Windows Audio example above, right panel, the LoopBeAudio virtual audio loopback driver is
selected as Input so that any Windows Audio and/or music/video application sound is passed through
convolution.

The output is set to a Topping E20 stereo DAC. A 96 kHz sample rate has been chosen along with 1024
sample buffer size.

You would adjust your settings for your particular usage scenario and then don't forget to click on the
Submit button:

In the case of the audio settings dialog submit, the audio parameters are sent. If an error occurred, an
error message will be displayed.

To retrieve the latest state from HLC's web server just refresh the browser using the refresh button or
press F5.

Load Filters

Step 2 - load a filter:

There are three examples, loading a single stereo.wav filter. Loading a zip file that typically contains
sample rates from 44.1 to 384 kHz versions of the same filter. FInally, loading .cfg files and matching .wav
files for multichannel operation.
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Single stereo .wav

Single stereo.wav filter:

In Filterbank 1, mouse click into Choose Files:

A file open dialog will display:

In this example, a single stereo .wav filter at 48 kHz is selected. Click Open:
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Note the filter has been selected but not uploaded to HLC. Click on the Upload button:

The filter is loaded.
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A zip of stereo .wavs

A .zip file containing stereo.wav filters with sample rates from 44.1 kHz to 384 kHz:

Choose whichever filterbank you wish to load. In this example it is Filterbank 2. Mouse click into the
Choose Files text box:

This will open the Open File Dialog window. Select a .zip containing stereo.wav (or mono) filters.

NOTE: for multichannel operation, use .cfg files.

Here the HF_Rolloff_65536_taps.zip filterset has been selected. Click Open:
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The filterset has now been selected. Click on the Upload button to send the filterset to HLC:

The fitlerset is loaded.
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A .cfg for multichannel operation

Loading .cfg and .wav files for multichannel operation:

In this example, Filterbank 3 is being used:

 Click on Choose Files text box:

In this example, a full set of filters (.cfg and corresponding .wav files) are to be uploaded from a directory.
Depending on the platform, shift (or control) select all the files in the directory:
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 and click Open. The web interface should look similar to this with all files selected:
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Now click on the upload button:

The web interface should look like this:
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NOTE: that the 96 kHz file is currently loaded as HLC's sample rate is set to 96 kHz.

From here one can switch between level matched filters in real-time from the web interface. Or make
changes to the Audio Settings.
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Closing HLC

Finally, when quitting the web browser, first click on:

What this does is tell HLC application to save all of its settings and shutdown. If you just close the browser
window, the settings will not be saved.

Clicking on Close Hang Loose Convolver will prompt before closing:

Clicking on Continue & Close:
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Plugin mode

Plugin mode is identical in behavior to Standalone mode except there is no Audio Settings dialog or Close
HLC button:
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Configuring HLHost application
HLHost.exe is a standalone application that can host any plugin including HLC plugin. Use HLHost when you
want to host more than one plugin or you wish to select/deselect active I/O channels or you wish to
"rewire" the routing between plugins.

This section shows how to configure HLHost with a:

· quick start guide for adding plugins
· more detailed guides for both stereo and multichannel operation on Windows and Mac (and similar for

Linux and Raspberry Pi).

Once HLHost has been configured, the settings are saved by selecting Save from the File menu. Once
saved, double clicking HLHost will restore the settings. 

Quick Start adding plugins

HLDSPSuite comes with HLHost for hosting "plugins." HLHost can also host HLConvolver plugin. The steps
outlined here describe how to add any plugin to HLHost and insert it into the audio signal path.

Adding and configuring a plugin to be inserted into the audio signal path is typically the same for each
plugin. Of course, each plugin's editor window is different depending on the purpose of the DSP for that
plugin. But the steps to add the plugin and connect it to the audio signal path follows a basic pattern
described here.

First we need to let HLHost know what plugins are available on your computer. Once you have been
through the following steps, then the configuration can be saved as a filtergraph. Then it is simply a matter
of double clicking on HLHost and everything will be restored just as you left it. Or have HLHost launch
automatically when the operating system boots.

From the Options menu, select, "Edit the List of Available Plug-ins..."

A Dialog Window will appear with an initial list of available plugins:
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By default, an Audio Input and Audio Output plugin will always be in the list and automatically added to the
canvas when New is selected from the File menu.

Select the Options... button and from the drop down, select, "Scan for new or updated VST3 plugins."
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Depending on the platform, there may be options to scan for Audio Unit (AU) plugins on the Mac or
LADSPA plugins on Linux, or another type of plugin format like LV2. Repeat the scan for each plugin format
as required.

The Scan locations are already filled in and in their respective locations as described in the System
Requirements. 

Important note: as one adds or updates plugins, it is normal procedure to rescan. If updating a plugin,
note the version number to ensure the updated plugin is loaded:
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Additional plugins have been found and added to the list of available plugins.

Important note: this dialog window needs to be closed otherwise there will be no sound.

Now we can add plugins onto the plugin canvas by right clicking on the canvas and selecting which plugin to
add:
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Now with the TDR plugin on the canvas, there are three ways to interact with the plugin:

1. Optionally right clicking on the plugin and selecting, "Configure Audio I/O.  This will configure the plugins
number of channels. Some plugins are stereo only and some have channel layouts up to 64 channels or
more.

2. Double clicking on the plugin will open up the plugins editor window so that the plugin's operational
parameters can be configured.

3. Finally, connecting the plugins digital I/O to insert the plugin into the audio signal path.

For example, right clicking on TDR Nova and selecting, "Configure I/O" the I/O dialog will appear:
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In this case, TDR Nova is a stereo plugin. Some plugins can be configured for multichannel operation.

Important note: please close this dialog window or there will be no sound.

Double clicking on TDR Nova brings up the plugin's editor window:
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Once the adjustments are made, then the editors window can be closed. In this example, we are going to
wire up the plugin to the inputs and output and then configure the audio settings. However, in practice, you
may have one or more plugins editor windows open while music is playing to make real audio time
adjustments.

Connect the the Audio input  plugins "output" pins to the input pins of TDR Nova and the TDR Nova output
pins to the input pins of the Audio output plugin. You do this by left clicking on a pin and dragging the pin to
the destination and letting go of the left mouse button when you are over the destination pin:

Now double click on either the Audio Input or Output plugin (or right click and select, "Configure Audio I/O").
The Audio Settings Dialog will appear:
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Depending on which platform you are on and type of audio device selected will determine the Audio
Settings options that are available to you. Select the the audio device type if available, the input and output
devices,and initial sample rate and buffer size. If you hear crackles or pops or static or stuttering, it
typically means more buffer size is required.

Important note: unless you are using h/w device loopback, or your audio interface supports routing
outputs into inputs, then a virtual audio loopback driver must be installed.

Once you have configured your Audio Settings, close the dialog.

The final step is to save your configuration. From the File menu, Select Save and give the filtergraph a
name and save to a location of your choosing.

Relaunching HLHost will remember the last state saved in the filtergraph and if the audio input and output
devices are available, just press play on your music player.
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Windows

In Windows, launch HLHost from the Start menu or the desk top shortcut:

The Window should look similar to above where there are stereo input and outputs exposed on the canvas.

From the Options menu, select Edit the List of Available Plug-ins:
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A Dialog will appear. Note that HLConvolver should already be in the list. If yes, then close the dialog
window and proceed to the next step.

If HLConvolver is not in the list, then from the Options... menu select, "Scan for new or updated VST3 plug-
ins:"
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Once the scan is complete, close the dialog window.

On the canvas, right click and from the context menu, select Accurate Sound -> HLConvolver:
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HLConvolver should now be instantiated on the canvas:
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By default, HLConvolver is configured for stereo operation. To configure HLC for multi-channel
configuration, right click on HLConvolver and from the context menu, select "Configure Audio I/O:"
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A dialog will appear where one can select the number of channels required:
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From the Channel Layout drop down, select the required number of channels for your multichannel setup:
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In this case, the 5.1 surround has been selected. Once selected, close the dialog window.

If one is using multi-channel for a stereo triamp system, as example, select the total number of channels
required as the "channel layout" is ignored and is simply used for the number of channels required.
If one is using multi-channel for a surround system, then select the number of channels and layout required.
If this were a 5.1 surround, then the 5.1 channel layout would be used.

Continuing with the 5.1 example, HLConvolver should now have 6 inputs and 6 outputs:

If one has a multi-channel DAC, then the next step is to configure the Input and Outputs.See the
multichannel section for more examples.

Returning to stereo or 2 channel operation for this section. Right click on either the Audio Input or Audio
Output and select, "Configure I/O:"
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An Audio Settings dialog should appear:
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Windows Audio (shared mode) is the recommended Device Type. However, there are other choices:

If one has an ASIO AD/DA converter, it may be possible to use the converters loopback capabilities rather
than the virtual audio driver. See hardware loopback.

Returning to the Audio Settings, select the Input and Output devices for your setup. In this case, the Input
is the Virtual Audio Cable output. So, whatever application is feeding the Virtual Audio Cable input will be
routed to HLC input. The output selected is the Topping E30 USB DAC.

Sample rate: choose 44.1 or 48 kHz to begin with.
Audio buffer size: choose 1024 samples to begin with. If one runs into any static or dropouts, increase the
audio buffer size to 2048 samples.
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Close the Audio Settings dialog window.

Next, "wire up" the inputs and outputs to HLC. To do this, left click on the left pin of the Audio Input, and
with the mouse button still down, drag the cursor to the left pin of HLConvolver and release the mouse
button. Continuing on and once finished wiring the audio, the canvas should look like this:

From the File menu, select Save. Select a location to save the settings file, give your preset a name, click
Save.

Remember the 5.1 triamp example from above. Here is what the convolver looks like wired up with a
stereo input and 6 channels of output.

Note a .cfg configuration file is required and must follow the convolver config specification as described
here: http://convolver.sourceforge.net/config.html Most DRC/DSP tools will output a .cfg config file along
with the filters. Once can also hand craft a .cfg file by following the spec and examples from the link
supplied. More details about the .cfg file can be found at Loading and Clearing Filters.
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The next step is to activate HLConvolver with your license key and then load a filter.

Double click HLConvolver (VST3) on the canvas, HLC's GUI will show (configured for stereo operation):
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Click the Activate button:
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Cut n paste the license key into the text-field and click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate. Don't forget to save first!
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Here the magnifying glass icon has been clicked, a file browser dialog opens, then the user has picked a
.zip file that contains stereo .wav filters ranging from 44.1 to 384 kHz and the convolver loads the matching
sample rate filter. Now one is ready to listen.

Don't forget to click on the Save button in HLHost. The next time HLHost is launched, it will load the
settings file and restore the state of the plugin.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters.
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Mac

In Mac, launch HLHost (was HLConvolverHost) from Applications:

The Window should look similar to above where there are stereo input and outputs exposed on the canvas.

From the Options menu, select Edit the List of Available Plug-ins:
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A Dialog will appear. Note that HLConvolver should already be in the list. If so, then close the dialog
window and proceed to the next step.

If HLConvolver is not in the list, then from the Options... menu select, 'Scan for new or updated Audio Unit
plugins" and "Scan for new or updated VST3 plug-ins:"
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Once the scan is complete, close the dialog window.

On the canvas, right click and from the context menu, select Accurate Sound -> HLConvolver:
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Note this could either be the VST3 or AU on Mac.

HLConvolver should now be instantiated on the canvas:



Hang Loose DSP Suite Operations Guide

118 / 197

By default, HLConvolver is configured for stereo operation. To configure HLC for multichannel configuration,
right click on HLConvolver and from the context menu, select "Configure Audio I/O:"



Hang Loose DSP Suite Operations Guide

119 / 197

A dialog will appear that one can select the number of channels required.

From the Channel Layout drop down, select the required number of channels for your multichannel setup:
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In this case, the 5.1 surround has been selected. Once selected, close the dialog window.

If one is using multi-channel for a stereo triamp system, as example, select the total number of channels
required as the "channel layout" is ignored and is simply used for the number of channels required.
If one is using multi-channel for a surround system, then select the number of channels and layout required.
If this were a 5.1 surround, then the 5.1 channel layout would be used.

Continuing with the 5.1 example, HLConvolver should now have 6 inputs and 6 outputs:

If one has a multichannel DAC, then the next step is to configure the Input and Outputs.See multichannel
section for more examples.

Returning to stereo or 2 channel operation for this section. Right click on either the Audio Input or Audio
Output and select, "Configure I/O:"



Hang Loose DSP Suite Operations Guide

122 / 197

An Audio Settings dialog should appear:
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Select the Input and Output devices for your setup. In this case, the Input is the BlackHole 2ch. Whatever
application is feeding BlackHole input will be routed to HLC input. The output selected is the Topping E30
USB DAC.

Sample rate: choose 44.1 or 48 kHz to begin with.
Audio buffer size: choose 512 samples to begin with. If one runs into any static or dropouts, increase the
audio buffer size to 1024 or 2048 samples.

Close the Audio Settings dialog window.

Next, "wire up" the inputs and outputs to HLC. To do this, click on the left pin of the input and with the
mouse button still down, drag the cursor to the left pin of HLConvolver and release the mouse button.
Continuing on and once finished wiring the audio, the canvas should look like this:



Hang Loose DSP Suite Operations Guide

124 / 197

From the File menu, select Save. Select a location to save the settings file, give your preset a name, click
Save.

Remember the 5.1 triamp example from above. Here is what the convolver looks like wired up with a
stereo input and 6 channels of output.

Note a .cfg configuration file is required and must follow the convolver config specification as described
here: http://convolver.sourceforge.net/config.html Most DRC/DSP tools will output a .cfg config file along
with the filters. Once can also hand craft a .cfg file by following the spec and examples from the link
supplied. More details about the .cfg file can be found at Loading and Clearing Filters.
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The next step is to activate HLConvolver with your license key and then load a filter.

Double click HLConvolver, HLC's GUI will show (configured for stereo operation):
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Click on the Activate button:
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Cut n paste the license key into the textfield and click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate. Don't forget to save first!
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Here the magnifying glass icon has been clicked, a file browser dialog opens, then the user has picked a
.zip file that contains stereo .wav filters ranging from 44.1 to 384 kHz and the convolver loads the matching
sample rate filter. Now one is ready to listen.

Don't forget to click on the Save button in HLHost. The next time HLHost is launched, it will load the
settings file and restore the state of the plugin.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters.
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Run Minimized

HLHost 1.2.6 adds a convenience method to run HLHost minimized upon startup. This can be selected from
the Options menu:

On Windows, HLHost shortcut can be placed in:

C:\Users\[username]\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup

Note in File Explorer, under the View menu, you may need to select Show -> Hidden Items to show the
AppData folder.

On Mac, once HLHost has launched, on the Doc, hover over the HLCHost icon and right click. Select
Options and then select Keep in Dock and Open at Logon.

NOTE: Version 2.x of HLP: DSP Suite can also run headless.
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Quick Start for VST3 and AU plugins

This section describes how to configure and activate the VST3 or AU plugins on both Windows and Mac.
Once the plugins are installed then they will show up for any applications that can host VST3 and AU
plugins.

The examples used here are for Audirvana and Reaper. However, the generalized procedure is similar for
any application that can host VST3 and AU plugins.

Windows

Audirvana

Launch Audirvana. Select the Settings on the top right to display all settings:

Under processing, select the gear icon:
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From the first drop down list, select Fx - Accurate Sound HLConvolver:

Click on Configure:
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Click on the Activate button:



Hang Loose DSP Suite Operations Guide

133 / 197

Cut n paste the license key and then click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate.
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HLConvolver is now activated. Click on the magnifying glass icon and load a filter. Click on Save. Close the
Processing dialog. Play a tune:

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters.
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Reaper

Launch Reaper. For digital room correction or headphone listening, most folks will insert HLConvolver in the
monitoring chain.In Repear, from the View menu, select Monitoring FX:

In the Add FX to monitoring dialog, select HLConvolver and click the Add button. Should now look like this:

Note that the FX is on the monitoring bus top right.
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Click on the Activate button:

Cut n paste the license key and then click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate.

HLConvolver is now activated. Click on the magnifying glass icon and load a filter. Click on Save. Play your
tracks:
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Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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Mac

Audirvana

Launch Audirvana. Select the Settings on the top right to display all settings:

Under processing, select the gear icon:
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From the first drop down list, select Fx - Accurate Sound HLConvolver:

Click on Configure:
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Click on the Activate button:

Cut n paste the license key and then click the Activate button. 
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The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate.

NOTE: There is a bug in Audirvana that after clicking on the Configure button, Audirvana does not save the
loaded filters or any other convolver settings when the Save button is clicked.

Please follow this procedure instead.

Note if you run into issues, try this workaround.

Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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Reaper

Launch Reaper. For digital room correction or headphone listening, most folks will insert HLConvolver in the
monitoring chain.In Repear, from the View menu, select Monitoring FX:

In the Add FX to monitoring dialog, select HLConvolver and click the Add button. Should now look like this:

Note that the FX is on the monitoring bus top right.
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Click on the Activate button:

After purchasing Hang Loose Convolver you should see a license key in a dialog pop up on the
accuratesound.ca web site and and email sent that contains the license key. This is described in the
section Purchasing Hang Loose Convolver. Cut n paste the license key and then click the Activate button. 

The window will disappear as will the main forms Activate button. Note: If Hang Loose Convolver does not
activate, close and reopen the application once or twice to activate.

HLConvolver is now activated. Click on the magnifying glass icon and load a filter. Click on Save. Play your
tracks:
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Note that the convolver passes no audio until a filter has been loaded.

More on multichannel configurations.

More on loading filters and the formats that are accepted.

More on level matching and switching filters
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Usage Guide

This section describes the basic operation of Hang Loose Convolver.

Loading Clearing Bypassing Filters
One can load a single stereo.wav filter, a .zip file containing one to many stereo.wav filters, a cfg
configuration file that adheres to the industry standard convolver "config" file specification.

Most features of the convolver config spec have been implemented, including:
· input and output delays with 0.1ms resolution.
· input and output channel weights.
· summing input channels to a single output path - typically used for cross-talk cancellation filters.
· both absolute and relative file paths to the filters are supported.
· supports mono and stereo .wav files 32 bit single precision floating point format. 
· If the host sample rate changes, HLC will look for a matching .cfg filter to load automatically.

In the case of a .zip containing one to many filters at different sample rates, HLC will automatically load the
correct sample rate filter. Note that if the Host requests a sample rate that is not in the .zip file, the zip
won't load and an error message will be displayed indicating that sample rate is missing.

Hang Loose Convolver supports filter sample rates from 44.1 kHz to 768 kHz.

Example loading a single .wav file:

With HLC open, click on the magnifying glass icon to open up the file dialog box:

http://convolver.sourceforge.net/config.html
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Example loading a zip file containing stereo.wav files from 44.1 to 384 kHz:
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Example loading .cfg file:



Hang Loose DSP Suite Operations Guide

148 / 197



Hang Loose DSP Suite Operations Guide

149 / 197

Note the host sample rate is set at 44.1 kHz in this example. The 48 kHz filter and signal will be resampled
to 44.1 kHz using the built-in resampler..

In Filterbank 2, the correct sample rate filter has been loaded from the .zip. If the host sample rate
changes, so does the filter.

In Filterbank 3, even though in the previous screen shot the 48.cfg file was selected, the correct 441.cfg
has been loaded.

Because stereo filters have been loaded, the Bypass button is enabled and one can compare filter to filter
or filter to bypass level which is also has a gain of 1.0:
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Here we see the Bypass button has been enabled and comparing bypass to Filterbank 3.

To clear a filter, simply click on the red X and the filter will be removed and the gain slider and settings will
be restored to no filter state:
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Multichannel .cfg considerations

Multichannel .cfg considerations:

Note that the Bypass is only enabled in stereo mode. With multichannel filters, the bypass button is
disabled. The reason for this is there is no way to determine what type of multichannel filter is loaded. For
example, perhaps a stereo triamp (6 channel) filter has been loaded. If the Bypass button is enabled and
selected that means each channel receives a full bandwidth signal, potentially damaging the tweeters.

For multichannel systems, most DSP/DRC software can generate a no-op (no operation) filter in which the
digital XO's are still in place, but there is no frequency or time domain correction. For some DSP software
one can get as granular as turning time alignment on or off with no frequency or excess phase correction.
Makes for great listening experiments comparing minimum phase to linear phase with or without time
alignment, or frequency correction or excess phase correction. It allows one's ears to tune into the effect
of each aspect of a successful digital room correction.

Most DSP/DRC software will auto generate the necessary .cfg files for various scenarios. For example,
one may see a folder of filters with both "2.0" and "5.1" .cfg files. Depending on the type of system that is
being corrected will determine which .cfg to load.

For example, in the stereo triamp (6 channel) scenario, the set of "2.0" .cfg files would be used and only
two channels of input are required. As it turns out for this particular scenario, the "5.1" cfg can also be
used as the .cfg file makes use of input summing and scaled weights so effectively the result is the same
as the "2.0". Lets look a bit more closely.

Here is an example stereo triamp .cfg file, just the first entry in the list:

2 input channels and 6 output channels.

Here is the same example, but as a "5.1" .cfg  with input summing and channel weights, just the first entry
in the list:

Note the 6 input channels.

https://www.youtube.com/watch?v=yfGAUvyvdNU
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What this is saying is:

1. You use channel 0 of the IR in the convolver.
2. you sum input channels 0, 2, 3, and 4, scaled as 0.63246, 0.34623, 1.0, and 0.63246 respectively, and
use that summed value as the input to channel 0 of the convolver
3. you take the output of the convolver and put it in Channel 4 of the output buffer. you scale the
output by 1.0

This .cfg file was auto generated from a DSP/DRC FIR filter designer.

In the case of a 5.1 "surround system," then the "5.1" .cfg file would be used as it is expecting 6 discrete
inputs and 6 discrete outputs:

It is also possible to have many different configurations where there is a 2 channel .cfg for stereo listening,
a 4 channel .cfg for a biamp setup of mains and subs, a 7.1 .cfg for surround, a 7.1.4 .cfg for Dolby
Atmos. For some DSP/DRC software, all of these .cfg's can be generated as one correction. In this case,
it is recommended to have different directories for each .cfg type or number of channels. That way
HLConvolver can still select the correct sample rate filter for that particular speaker configuration.

See Example Configs for more convolver config examples or the multichannel examples section.

http://convolver.sourceforge.net/configegs.html
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Level Matching Filters
As discussed in the section Why Hang Loose, level matching filters to the bypass level is a great way to
refine your listening experience. Level matching can be done by just listening to music while adjusting the
gain slider for the active filterbank and clicking the bypass button on and off. Note that with the AutoGain
feature, the level match should be quite close to begin with and no further adjustment required.

One can precisely level match the filter(s) to the bypass level by playing the pink noise file that was
installed during product installation. Simply play the PN file on repeat while adjustments are made. One can
use a sound level meter, either hand held or a downloadable app for your phone to measure the sound
pressure level (C weighting, slow or average response) when clicking the bypass button off or on. Or one
can simply view the output meters to match the level.

Try to get as close as the same SPL (or meter) reading for when the filter is engaged and bypass mode.

Given that correction filters are custom designed for your loudspeakers and room or headphones, some
adjustment may be required. 

One may run into a scenario where the incoming signal is "too hot" and clips the audio signal as shown
below in bypass mode:

Here we see the level is too high in bypass mode and the resultant clipping. To clear the clipping indicator,
either click on the red peaks or the dB indicators on the meter.

With Hang Loose Convolver in bypass mode, turn down the Master Trim control until there is no clipping.
Then turn Bypass off and adjust the active Fitlerbank gain slider until the level matches the bypass level.
One may need to fine tune a few times to ensure there is no clipping, while the levels match.
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With the Master Trim turned down a bit and the active filterbank gain slider turned up so that the level with
the filter engaged is the same level as with the filter bypassed, we are now ready to listen to music.

Wile the gain sliders have a +- 12 dB range, as does the Master Trim, only small changes like a couple dB
or so should be required. If there are larger changes required, there may be a gain staging issue prior to
HLConvolver or the filters themselves have an issue.
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Switching Filters
As described in the section, Why Hang Loose, our audio echoic memory last between 1 to 10 seconds.
When evaluating filters or filter versus bypass level, try switching back and forth over 30 second intervals.
This will give you a "first impression" as to which filter you prefer.

A more casual approach is to listen over a period of time and then switch filters. Or, try listening to a
number of tunes in a row and then switch.

In this example, a linear phase filter is being compared with a minimum phase filter. Even though the linear
phase filter may have it's own kernel delay, there is no delayed sound between switching filters:

Once can also compare multichannel filters:
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Filter switching is instantaneous regardless if the filter is a linear phase, mixed phase or minimum phase
filter or the number channels.

If you are interested in achieving accurate sound, there is a technical approach described in this article,
"What is Accurate Sound?" There is a section on what does accurate sound "sound like" to assist in what
to listen for.

https://audiophilestyle.com/ca/bits-and-bytes/what-is-accurate-sound-r923/
https://audiophilestyle.com/ca/bits-and-bytes/what-is-accurate-sound-r923/#1
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Resampler Usage
HLC uses a high quality pro resampler-to maintain filter frequency resolution for any sample rate:

E.g. a FIR filters frequency resolution =  fs / N where fs is the sample rate and N = number of FIR filter
taps. So a 44.1 kHz, a 65,536 tap FIR filter has a frequency resolution of: 44100/65536 = 0.67 Hz. 

So to maintain the same frequency resolution at 705,600 sample rate = 705600/44100 = 16. 16 x 65,536
taps = 1,048,576 tap filter is required. That is theoretically speaking as the resampler itself takes up some
number of samples to perform its operation. So the end filter is 1,022,146 taps (as shown in the pice) in
order to keep the same 0.67 Hz frequency resolution of the original FIR filter.

HLC resampler works with .cfg files only. The resampler is engaged when HLC cannot find a matching
sample rate filter when a filter is being loaded or when the host sample rate changes.

HLC provides user adjustable controls to fine tune the resamplers settings per filterbank:

% = transition band is specified as the normalized spectral space of the input signal between the low-pass
filter’s -3 dB point and the Nyquist frequency. Ranges from 0.5% to 45%.Basically this effects at what
frequency the filter starts to roll off at. With the control all the way to the left means that the roll off will
start as close to Nyquist as possible. All the way to the right will start rolling off early.

dB = stop-band attenuation can be specified in the range from 49 to 218 decibels. With the control all the
way to the left means minimum stop band attenuation and all the way to the right is maximum stop band
attenuation.

Phase = linear or minimum phase.Linear phase is a perfect straight line phase throughout the frequency
range. Minimum phase has an adjustment in the top octave that is more intimate than linear phase. As
always, let your ears choose what you prefer.

Double clicking on the resampler controls will reset to default settings.

Here’s an example showing the range of HLC’s resampler settings downsampling 96 kHz to 44.1 kHz:

https://github.com/avaneev/r8brain-free-src
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The orange trace is the default setting, the green trace is an intermediate setting and the blue trace is the
minimum setting with optional minimum phase set.

To fine tune the resampler settings, load two Filterbanks with the same .cfg filter at one sample rate (e.g.
44.1 kHz). Leave one Filterbank with default settings and adjust the resampler controls for the 2nd
Filterbank. Play music at a different sample rate to engage the resampler. Switch between the two
filterbanks in real-time to tune in to the differences. Choose whichever settings sound best to your ears.

Should I use the highest sample rate filter?

Conventional wisdom has been to use the highest sample rate filter available in thinking this filter has the
highest frequency resolution. Unfortunately, with fixed tap length filters that most DSP programs output,
means that as the sample rate increases, the filters frequency resolution decreases.

As mentioned above, a FIR filters frequency resolution =  fs / N where fs is the sample rate and N =
number of FIR filter taps. 

So a 44.1 kHz, a 65,536 tap FIR filter has a frequency resolution of: 44100/65536 = 0.67 Hz. 

At 705,600 sample rate with a 65,536 tap filter, the frequency resolution becomes:705600/65536 = 10.7
Hz. So 10.7 Hz/0.67 Hz = 16. So the 352,800 FIR filter has 16 times less resolution than a 44.1 kHz. FIR
filter that has been upsampled to 705.6 kHz sample rate. 

The frequency range spans 0 Hz to 22.050 kHz (fs/2). Thinking of a FIR filter as a graphic equalizer:
22050/0.67 = 32768 eq sliders for our FIR equalizer. Thinking of it another way, remember 1/3 octave 31 -
band graphic equalizers? Our FIR filter has 1000 times the resolution of a 31 band eq. So while it is
unlikely one can hear a difference even with a filter that is 16 times less resolution when we are comparing
different sample rate filters with a "fixed" number of taps, technically speaking the highest sample rate filter
does not necessarily result in a higher resolution.
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Accurate Sound's recommendation, if using the resampler, is to use the native DSP measurement
resolution that the measurement was taken at. In almost all cases that would be a 48 kHz correction filter.
Therefore, just generate a 48 kHz .cfg file and corresponding filter from the DSP/DRC design tool and load
that as the only filter and let the resampler maintain the frequency resolution of the native filter regardless
of host sample rate.
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Latency Compensation
Hang Loose Convolver is a zero latency (i.e. 0 millisecond) convolver which adds no inherent delay into the
signal path. That means a 65,536 tap minimum phase FIR filter will be processed immediately with no
audible delay. This makes for a good choice when lip sync is required but one wants the full frequency
resolution of the filter especially at low frequencies.

However, linear phase FIR filters do have an inherent delay that can be calculated, using the formula: (N –
1) / (2 * Fs),  where N is the number of filter taps and Fs is the sampling frequency. So (65,536 - 1)/2 * 48
kHz) = 682 milliseconds of delay.Converting into samples, the formula is: milliseconds times the sample
rate = # of samples. (0.682 x 48000) = 32,736 sample delay.

HLC calculates the FIR filter delay in samples for each filterbank and displays the filter with the most delay
in samples. If one or more filterbanks are loaded with minimum phase filters, then HLC will display 0
latency samples. If it is a mix of linear phase and minimum phase filters, then whichever filter with longest
delay will display as the latency in samples. This means that the delta between all filters loaded in HLC will
be calculated and offset to match the filter with the longest delay. So if wanting no delay, then just load
minimum phase FIR filters only and save as a preset (i.e. a filtergraph). Then create another filtergraph
with linear phase filters and save as a seperate fitlergraph. 

The latency in samples is also sent to the host application. Almost all DAW's and some consumer music
applications can read the FIR filter latency value and compensate for the reported latency. For example,
DAW's use latency compensation introduced by plugins so that playback sounds in sync when tracking. In
the case of a music or video applications, the reported delay is compensated for perfect lip sync
regardless of the delay of the FIR filter.

Additional information:

For people interested in implementing high resolution "minimum" phase filters for movie playback, the
following tests were performed using Lynx Studio gear to test a standalone DSP Processor using Lynx's
AES16e 16 channel digital I/O card on Windows. The goal is to prove one can use long tap length (65,536
taps) convolution FIR filters for movies with less than 22ms of round trip latency. Long tap FIR filters (e.g.
65,536 taps) provide excellent low frequency control below 100 Hz, right where you need the power for
effective digital room correction.

As already noted, for music/movie production, studios use DAW’s that has latency compensation built in
which takes care of any latency reported by the VST3/AU plugins and adjusts the video so that both the
audio and video are in sync. Same approach for tracking/overdubbing. Some consumer applications
like JRiver also can do this. But for "standalone" music and movie sound reproduction rooms that are not
outfitted with DAW's, there is currently no way to report audio latency back to the media player application
that’s running in a separate process. This is an issue for lipsync. However, one can mitigate this by using a
0ms latency convolver and pro audio gear with direct audio connections via ASIO protocol.

Test setup is computer 1 with a Lynx Hilo attached using a media player application to play music and
movies. The Hilo's AES output is AES input to the AES16e card in a 2nd computer. HLHost application
hosts the HLC VST3 convolution plugin on the 2nd computer. HLC is processing a 65,536-tap minimum
phase FIR filter, with AES16e output back to the Hilo AES digital input. Hilo DAC output is connected to
amps/speakers and headphones. The AES16e was slave to the Hilo; tested using sync from the AES
digital input signal or Hilo's external clock output. Results were identical with either setting.

Step 1 was use REW on computer 1 to produce a loopback sweep through the entire digital I/O chain,
including convolution with a Dirac pulse 65,536 tap minimum phase FIR filter. As expected, perfectly flat
frequency and phase response. Looking at REW's distortion tab was about -150 dBFS across the
frequency spectrum. Computer 1 is a 12-year-old i5 CPU with Windows 10 loaded to the hilt with apps and
services. Still, -150 dBFS is well below our hearing threshold.

Next up is to play movies while reducing both interfaces ASIO audio buffer sizes until dropouts/static was
heard and then backed off until the audio was solid with no dropouts. This is done before measuring the
round-trip latency so as not to "game" the numbers. It is easy to reduce the buffer sizes to next to nothing
when sending a test pulse to get the lowest latency numbers, but it won’t play continuous audio without

https://yabb.jriver.com/interact/index.php/topic,136225.0.html
https://yabb.jriver.com/interact/index.php/topic,136225.0.html
https://en.wikipedia.org/wiki/Audio-to-video_synchronization#Recommendations
https://yabb.jriver.com/interact/index.php/topic
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massive dropouts/static.

Round Trip Latency (RTL) Utility is used to measure the end-to-end latency. The utility is run on computer 1
and reported the following latencies with convolution engaged at different sample rates on the 2nd
computer. This test at 96 kHz sample rate with 65,536 tap minphase FIR filter:

Other tested sample rate latencies:
48 kHz: 14.875ms.
192 kHz: 8.625ms.

Comparing bypass to 262,144 tap FIR filter:
Bypass: 48 kHz: 14.875ms.
48 kHz 262,144 taps minphase FIR filter: 14.896ms.

Effectively 0ms latency convolution. 

https://oblique-audio.com/rtl-utility.php
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Latency Display
HLC version 1.2.6 implements a convenience method for displaying the FIR filter latency in either samples
or seconds via a "units" button.

Display in samples:

Display in seconds:

As filters are loaded or deleted, the latency is updated in real-time.

The units are an automatable parameter, so once set, it will be saved and restored upon exciting and
launching HLC.
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Automatic bypass in supported DAW's
Some DAW's (e.g. Logic Pro) have a "render mode" when the mix is being "printed" or rendered as a 2
channel mix. Pro Tools render mode is called bouncing. HLC can detect render/bounce mode and will
automatically bypass the filters when the DAW is in render/bounce mode. This prevents the correction
filters from being accidentally being rendered (i.e. printed) to the mix.
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Instant switching mode and performance mode
HLC application and plugin now expose two modes of operation called Instant Switching mode and
Performance mode.

The button switch can be found to the right of the Latency display (in samples or seconds) button:

Hovering over the button will display a tool tip:

The default value is Instant (Inst) switching mode. This places the convolver in its normal operation of
instantly switching between filters (and bypass in stereo mode).

However, there is a performance trade off using this mode of operation as it requires more CPU
processing. 

If it turns out that while using really long FIR filters and/or high samples rates that audio static or drop outs
occur, and the buffer sizes have been maxxed out, then turn Performance mode on by clicking the button:

Here HLC is now running in performance mode and any static or drop outs should be resolved. The trade-
off is that HLC will still switch Filterbanks, but it will not be instant. There will be a delay (of silence) when
the filter switches.

NOTE: Typically, performance mode is engaged only when running really long filters and/or high sample
rates where you are looking to get the last bit of performance out of HLC.
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HLC OpenAPI specification REST API
HLC provides a REST API that uses the OpenAPI specification. What this means is that HLC can be
controlled from any application or web interface using simple web API calls.

This not only allows for custom user interfaces to be developed for HLC, but by running headless, any
application can send REST API calls to load a filter, switch a filterbank, etc. Every user control available in
the web interface can be called via the REST API to HLC that can run headless on Windows, Mac, Linux
and Raspberry Pi OS.

To view the documented HLC REST API, one can use Swagger UI to view and interact with HLC API.

Viewing HLC Web API specification

Swagger UI allows anyone to visualize and interact with the API’s resources without having any of the
implementation logic in place. It’s automatically generated from HLC's OpenAPI Specification, with the
visual documentation making it easy for back end implementation and client side consumption.

Loading HLC Yaml spec into Swagger UI visually displays the documentation:

https://swagger.io/docs/specification/v3_0/about/
https://editor-next.swagger.io/
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The screen shot is just a snippet of the spec.

Download HLC openAPI spec by right clicking on the hyperlink and select Save as... then choose a location
on your hard drive and save.

Open a web browser and navigate to: https://editor-next.swagger.io/

From the Swagger UI File menu, select Import File and navigate to the Yaml spec that was just
downloaded, select, and open. 

Now one can peruse through all aspects of HLC's REST API.

Further, one can interact with a live instance of HLC right on a local computer. The next section describes
how to do this:

https://accuratesound.blob.core.windows.net/sotadrc/openapi_spec.yaml
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Interacting with a live HLC instance

The easiest and fastest way to interact with a live instance of HLC is to use Docker to run Swagger UI
locally:

1. Download and install Docker Desktop: https://www.docker.com/products/docker-desktop/

2. Once Docker is installed, launch the application.

3. Then from a command line interface execute these commands:

4. docker pull swaggerapi/swagger-editor:next-v5 # run this only once

5. docker run -d -p 8888:80 swaggerapi/swagger-editor:next-v5

6. NOTE: It's important to use port 8888 because that's the only port the server allows.

7. Launch an instance of HLC either in native GUI mode or headless mode.

8. Open a web browser and navigate to: http://localhost:8888/

9. Download HLC openAPI spec by right clicking on the hyperlink and select Save as... then choose a
location on your hard drive and save.

10. From the Swagger UI File menu from http://localhost:8888/, select Import File and navigate to the
Yaml spec that was just downloaded, select, and open.

Your screen should look like this:

https://accuratesound.blob.core.windows.net/sotadrc/openapi_spec.yaml
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Now one can interact with the live instance of HLC using the REST API.

In this example, HLC application is running on Windows using its native interface so we can see the result
of making the web API calls from Swagger UI running on the local computer.

Example: loading a FIR filter using the web API:

Under the section Filterbank Control, click on the down arrow for POST filter:
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Click on Try it Out button:

In the filterid field, type in 0. 0 is Filterbank 1 in HLC, 1 is Filterbank 2 and so on:
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Click on Choose File button and select a filter to upload to HLC:
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A Open File dialog box will be displayed. Choose a filter. In this stereo example, a zip file containing a
range of 44.1 to 384 kHz sample rates for the filter is selected. Click on the Open button:

Now that the required fields for filterid and filter file(s) are filled, click on the Execute button:



Hang Loose DSP Suite Operations Guide

173 / 197

Note that HLC GUI now has Filterbank 1 loaded with the HF_Rolloff_65536_taps.zip filterset.

Scrolling down a bit in Swagger UI, one can see the response code from the HLC server. Code 201 means
file successfully loaded and the response body contains the loadedFilterFile that was uploaded to the
server.

Watch for a YouTube video Accurate Sounds YouTube channel.

https://www.youtube.com/@accuratesound4115
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Configuration Files

This section describes the use and management of convolver configuration files.

Overview of .cfg Files
HLC has implemented the industry standard config file specification.

Specifically, HLC implements:

· input and output delays with 0.1ms resolution
· input and output channel weights
· summing input channels to a single output path - typically used for crosstalk cancellation filters
· both absolute and relative paths to the filters are supported
· if the Host sample rate changes, HLC will look for a matching .cfg file to load automatically. If no

match, then HLC will resample the filter to match.

It should be noted that the config (i.e. .cfg) file is typically automatically generated by the DSP FIR Filter
Designer tool that one is using. Acourate, Audiolense and Focus Fidelity Designer all support the automatic
 generation of .cfg files. If the DSP FIR Filter Designer tool does not support the automatic generation of
.cfg files, then please forward the industry standard specification and have the developer implement it.

The use of these DSP FIR Filter Designer tools that support the automatic generation of the .cfg file is
recommended, especially for complicated configurations, like this one:

This is a 5.1 surround system with an extra sub. So 6 inputs and 7 outputs. In addition, bass management
using digital crossovers are being used so that the bass below certain frequencies from each speaker (left,
right, center, left surround and right surround) are being offloaded to the 2 subs.

While there are 6 inputs and 7 outputs, there are 17 impulses responses (i.e. paths) to be convolved with

https://convolver.sourceforge.net/config.html
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the outputs from channel 7 to 16 to be summed (with a scale factor of 1) into the two subwoofer channels
(3 and 6) as determined by the filter paths in the .cfg file.

The diagram visualizes the 17 paths in the .cfg file. Basically the left, right, center, left and right surround
have digital XO's that offload to 2 sub woofers. The LFE channel feeds the two subs. So a direct path to
each channel is 6 paths. The extra sub is the 7th path. and then each speaker has two feeds to the two
subs. So 5 speakers to 2 subs is 10 paths, for a total of 17 paths (i.e. 17 convolvers).

In this case, the .cfg file was automatically output from one of the DSP FIR FIlter Designer tools linked
earlier. "Hand crafting" a .cfg of this complexity is not recommended, but is doable.

Let's take a look at the .cfg file that was automatically generated:

48000 6 7 0
0 0 0 0 0 0
0 0 0 0 0 0 0
MCH_filter48.wav
0
0.0
0.0
MCH_filter48.wav
1
1.0
1.0
MCH_filter48.wav
2
2.0
2.0
MCH_filter48.wav
3
3.0
3.0
MCH_filter48.wav
4
3.0
6.0
MCH_filter48.wav
5
4.0
4.0
MCH_filter48.wav
6
5.0
5.0
MCH_filter48.wav
7
0.0
6.0
MCH_filter48.wav
8
0.0
3.0
MCH_filter48.wav
9
1.0
6.0
MCH_filter48.wav
10
1.0
3.0
MCH_filter48.wav
11
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2.0
6.0
MCH_filter48.wav
12
2.0
3.0
MCH_filter48.wav
13
4.0
6.0
MCH_filter48.wav
14
4.0
3.0
MCH_filter48.wav
15
5.0
6.0
MCH_filter48.wav
16
5.0
3.0

Note that the "MCH_filter48.wav" is a multichannel .wav file containing 17 impulses, but in the .cfg file, it
starts at 0 and ends at 16, so zero based.

The top line of: 48000 6 7 0
Means this .cfg file points to 48 kHz filters. There are 6 input channels and 7 output channels. The 0 on the
end is an "output channel mask" which is typically not used, so 0 is used to denote no output channel mask.

The next two lines of:
0 0 0 0 0 0
0 0 0 0 0 0 0
Are the input (top) and output (bottom) channel delays for each of the input and output channels. In most
cases these are 0 as the DSP FIR Filter Designer software will have the delays built into each  impulse
response along with the digital crossovers and input/output channel weightings.

So the .cfg file, in this case is mostly used for channel routing, called filterpaths:

Starting at the top with:
0
0.0
0.0

Top line is the channel number in the multichannel wav file (e.g. MCH_filter48.wav).
Route input channel 0 (top) to output channel 0 (bottom). 0 representing the left channel.

Next are:
1
1.0
1.0

Route input channel 1 to output channel 1. 1 representing the right channel.

One can see the pattern. Now lets pick one that is different like channel 16:
16
5.0
3.0

Route input channel 5 to output channel 3. If you look at the drawing at impulse 16, one can follow the dark
green line from the Right Surround to Sub0. In fact, one can follow the color coded traces for each channel
in the .cfg file.
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Note the path used for "MCH_filter48.wav" is a relative path. HLC will look for the this multichannel .wav file
in the same directory as the .cfg file.
Also note that the above .cfg example, while a 5.1 surround system with two subs, it requires 17 filterpaths
and therefore 17 convolutions (or 17 convolvers) to make work due to the bass offloading.

There are more multichannel configuration examples coming up, but first a few thoughts about managing
one's configuration files.
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.cfg File Management
When designing and generating FIR filters with .cfg files, one can accumulate quite a few when going
through a listening session comparing filters. Often one is generating filters and .cfg files all in the same
directory. It can be useful to organize the .cfg files (and corresponding wavs) into a directory structure.

When a song is played, HLC gets the host's sample rate and looks for a matching sample rate filter in the
same directory. It does so by parsing the filename looking for a matching sample rate, like
"name_of_my_config_441_2.0.wav" file. For example, if the source sample rate is 44.1 kHz, HLC will look
into the current directory for a matching 44.1 kHz sample rate .cfg file. If it finds one, it loads it, if it does
not find one, then the resampler kicks in.

In some cases, multiple .cfg files are generated for different channel layouts in the same directory. For
example, a Dolby Atmos system may have .cfg files for 5.1.4, 5.1, 2.1, 5.0. 7.1 or more depending on
source number of channels. HLC cannot differentiate between multiple .cfg files with the same sample
rates, but different channel layouts.

If your multichannel surround system can use different channel layouts, it is recommended to separate the
multichannel .cfg files so that all all stereo.cfg sample rate filters (i.e. wav files) are in one directory and all
5.1 surround .cfg files (and corresponding wavs) are in another directory and so on. That way when the
sample rate switches, HLC will load the correct sample rate filter for the correct channel layout.
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Multichannel .cfg examples

There are many combinations of multichannel systems which makes it difficult to cover all possible
scenarios. It can range from a stereo mains with dual subs, to a stereo triamp system, to a surround
system with many different channel configurations from 5.1 to 7.1.4 Dolby Atmos systems.

This chapter discusses a few multichannel setups with examples.

Important note about digital crossovers
If one is using HLC in multichannel mode with digital crossovers, it is important to verify proper crossover
operation before hooking up drivers. This is to ensure that bass frequencies are not being sent to the
tweeters.

Here is an example of how this can happen. This is a stereo 4-way digital XO system where the Acourate
is used to generate the .cfg file. Acourate crossovers (and correction filters) are generated in the
sequence 1L, 1R, 2L, 2R, 3L, 3R, 4L, 4R. Meaning bass left, bass right, lower midrange left, lower
midrange right, upper midrange left, upper midrange right, tweeter left, and tweeter right.

And if the .cfg is loaded in the convolver, one is tempted to simply route the output channels of the
convolver 1:1 mapping with the output channels of the DAC. Like this:

However, it depends on how the outputs are hooked up from the Audio Output (i.e. DAC) to the
amps/drivers. It could be that  Audio Output channel 1 and 2 are hooked up to the left and right tweeters.
And as already defined in the .cfg, that means the bass frequencies are being sent to the tweeters. Not
good.
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In this case Audio Output 1 and 2 are going to the tweeters. So the output of the convolver pins 7 and 8
need to go to pins 1 and 2 on the Audio Output:

And pins 1 and 2 of the convolver with the bass output going to pins 7 and 8 on the Audio Output. This
resolves the issue. While it is very flexible to route any I/O without physically swapping cables, it is
important to know how the .cfg is output and if any channel mapping is required between the convolver
outputs and the inputs to the Audio Output.

Another example is Audiolense, in which the application itself can assign routing in the .cfg, so more often
than not, it is a 1:1 mapping from convolver output to audio output.

The "best practice" is to double check the convolver outputs. The best way to achieve this is to hook up a 2
channel DAC (or motherboard) with a headphone output. And checking the volume before putting on the
headphones, while playing music, wire convolver pins 1 and 2 to output to the left and right outputs of your
DAC and listen to hear if low or high frequencies are passing through. Something like this:
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Do that separately for each set of stereo pins going from left to right and noting the convolver output. It
should match exactly to the .cfg. Here just listening to convolver output 7 and 8 and from the .cfg above,
those are the tweeter outputs and sounds like that in the headphones. 

Not only are we checking for high pass or low pass operation and mapping that to the correct Audio Output
channels, but ensuring we are hearing what we expect to hear from each filters output. This is before we
hook up the configuration to amps and drivers. This will prevent any unwanted surprises.

For a "belt and suspenders" engineering approach, it is recommended to put a protection capacitor on
each tweeter. Especially true for compression drivers, ribbons are more forgiving as are dome tweeters.

https://www.audioheritage.org/vbulletin/attachment.php?attachmentid=49454&d=1295365145
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Basic stereo.cfg
From the config file samples, here is an example of a stereo configuration using two mono impulse files:

44100 2 2 0

0 0

0 0

C:\Impulses\LeftIR.wav

0

0.0

0.0

C:\Impulses\RightIR.wav

0

1.0

1.0

44.1khz, stereo in and out, no speaker mapping
No delay on any input channel (feature introduced in version 3.1)
No delay on any output channel (feature introduced in version 3.0)

Take the first (and in this case only) channel from Left.wav
Apply Left.wav to the first input channel
... and output the result to first output channel

In the case of a stereo.wav filterset, the .cfg is identical except the path points to the same filter.wav file.
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Cross-talk cancellation filter
This is an example cross talk cancellation filter for headphones. This example is included with the HLC
install so one can try it out.

While technically not a multichannel setup, it does require 4 convolver channels. It consists of two stereo
filters. Left.wav and Right.wav with each stereo file consisting of left and right channels. The formula is:

Yl = Xl * Leftl + Xr * Rightl
Yr = Xr * Rightr+ Xl * Leftr

X  represents the input and Y the output, and * is the convolution operation.

The config file looks like this:

44100 2 2 0
0 0
0 0
Left.wav
0
0.0
0.0
Left.wav
1
0.0
1.0
Right.wav
0
1.0
0.0
Right.wav
1
1.0
1.0

HLConvolverHost setup:
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Right click on HLConvolver and select, "Configure Audio I/O." Select "Quadrophonic" from the channel
layout drop down list. Close the dialog box.

Wire HLC as shown above. Right click on either Audio Input or Output and select, "Configure Audio I/O." In
the case above, the input is "Cable output (VB- Virtual Audio Cable) which allows any application or system
wide audio to be routed into HLConvolver. Select your DAC as the output.

Don't forget when selecting inputs and outputs the same rate and buffer size may reset. Select either 44.1
or 48 kHz to begin with a  buffer size of 1024 samples.

Double click on HLConvolver to bring the UI up:
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Filterbank 1 has the headphone cross-talk cancellation filter loaded.

Filterbank 2 has a Dirac pulse loaded. Effectively a "pass through" filter that represents the same signal if it
were bypassed. This allows one to switch between the cross-talk cancellation filter and "bypass" so one
can hear the difference clearly.
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Stereo triamp 6 channels
This is an example of a stereo triamp (6 channel) system using digital XO's in addition to digital room
correction. The output of the multichannel DAC is fed directly into the amplifiers and directly into the
speakers. The volume is controlled digitally in the music player application.

A typical .cfg file for this looks like:

44100 2 6 0
0 0
0 0 0 0 0 0
JBL_4722_F18_subs_linear_phase_441.wav
0
0.0
4.0
JBL_4722_F18_subs_linear_phase_441.wav
1
0.0
0.0
JBL_4722_F18_subs_linear_phase_441.wav
2
0.0
2.0
JBL_4722_F18_subs_linear_phase_441.wav
3
1.0
5.0
JBL_4722_F18_subs_linear_phase_441.wav
4
1.0
1.0
JBL_4722_F18_subs_linear_phase_441.wav
5
1.0
3.0

Note this is also a valid .cfg using 3 sets of stereo.wav files as opposed to a single multichannel file:

48000 6 6 0
0 0 0 0 0 0
0 0 0 0 0 0
Cor1S48.wav
0
0.0
0.0
Cor1S48.wav
1
1.0
1.0
Cor2S48.wav
0
0.0
2.0
Cor2S48.wav
1
1.0
3.0
Cor3S48.wav
0
0.0
4.0
Cor3S48.wav
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1
1.0
5.0

Also note the output routing is different. In the top example, channel 1&2 are the mids, channel 3&4 is
treble and channel 5&6 is the bass.
Conversely, the 2nd .cfg is channel 1&2 is the bass, 3&4 mids, and 5&6 treble.

Some DSP/DRC software allows you to re-route the outputs where as others have a fixed layout.
Something to keep in mind as both .cfg files are valid.

Looking at the convolver configuration for the first .cfg:

Right click on HLConvolver and select, "Configure Audio I/O." Select "5.1" from the channel layout drop
down list. Close the dialog box. Note, in this case we are not so much concerned with the channel layout
as we are the total number of channels required. Any one of the channel layouts that equals 6 channels or
greater will work.

Wire HLC as shown above. Right click on either Audio Input or Output and select, "Configure Audio I/O." In
the case above, the input is "Cable output (VB- Virtual Audio Cable) which allows any application or system
wide audio to be routed into HLConvolver. Select your multichannel DAC as the output. Note 6 DAC
channels is required.
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Don't forget when selecting inputs and outputs the same rate and buffer size may reset. Select either 44.1
or 48 kHz to begin with a  buffer size of 1024 samples.

Double click on HLConvolver to bring the UI up:

Note there are three filterbanks loaded:

Filterbank 1 = linear phase filter.
Filterbank 2 = minimum phase filter with linear phase digital XO.
Filterbank 3 = minimum phase filter with minimum phase digital XO.

The filters created all use exactly the same target frequency response and correction procedure
parameters. The only variable that has changed is from a timing perspective:

The linear phase filter has excess phase correction applied in addition to linear phase crossovers.
The minimum phase filter does not have excess phase correction applied, but does use a linear phase
crossover.
The minimum phase filter does not have excess phase correction applied, and is using a minimum phase
crossover.

This sets up an interesting experiment. Can one hear the difference between the filters when the only
change is from a timing perspective. The answer is provided in this YouTube video: Hang Loose Convolver
- A Listening Demonstration

https://youtu.be/0nCdz_BXgBI
https://youtu.be/0nCdz_BXgBI
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8 channel mono triamp dual subs
An example of 8 mono channel stereo triamp with dual subs:

96000 2 8 0
0 0
0 0 0 0 0 0 0 0
lw.wav
0
0.0
0.0
rw.wav
1
1.0
1.0
lm.wav
0
0.0
2.0
rm.wav
0
1.0
3.0
lt.wav
0
0.0
4.0
rt.wav
0
1.0
5.0
Asub.wav
0
0.0
6.0
Bsub.wav
0
1.0
7.0



Hang Loose DSP Suite Operations Guide

190 / 197

7.1.4 Dolby Atmos
It is possible to play Dolby Atmos material from a computer that does not have an AVR or PrePro
attached. See article on How To Decode and Play Dolby TrueHD Atmos on Windows and macOS.

The .cfg file for a 7.1.4 Dolby Atmos system looks like this:

44100 12 12 0
0 0 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0
Dolby_Atmos_7.1.4_441.wav
0
0.0
0.0
Dolby_Atmos_7.1.4_441.wav
1
1.0
1.0
Dolby_Atmos_7.1.4_441.wav
2
2.0
2.0
Dolby_Atmos_7.1.4_441.wav
3
3.0
3.0
Dolby_Atmos_7.1.4_441.wav
4
6.0
6.0
Dolby_Atmos_7.1.4_441.wav
5
7.0
7.0
Dolby_Atmos_7.1.4_441.wav
6
4.0
4.0
Dolby_Atmos_7.1.4_441.wav
7
5.0
5.0
Dolby_Atmos_7.1.4_441.wav
8
8.0
8.0
Dolby_Atmos_7.1.4_441.wav
9
9.0
9.0
Dolby_Atmos_7.1.4_441.wav
10
10.0
10.0
Dolby_Atmos_7.1.4_441.wav
11
11.0
11.0
Dolby_Atmos_7.1.4_441.wav
12
0.0
3.0

https://audiophilestyle.com/ca/immersive/how-to-decode-and-play-dolby-truehd-atmos-on-windows-and-macos-r1092/
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Dolby_Atmos_7.1.4_441.wav
13
1.0
3.0
Dolby_Atmos_7.1.4_441.wav
14
2.0
3.0
Dolby_Atmos_7.1.4_441.wav
15
6.0
3.0
Dolby_Atmos_7.1.4_441.wav
16
7.0
3.0
Dolby_Atmos_7.1.4_441.wav
17
4.0
3.0
Dolby_Atmos_7.1.4_441.wav
18
5.0
3.0
Dolby_Atmos_7.1.4_441.wav
19
8.0
3.0
Dolby_Atmos_7.1.4_441.wav
20
9.0
3.0
Dolby_Atmos_7.1.4_441.wav
21
10.0
3.0
Dolby_Atmos_7.1.4_441.wav
22
11.0
3.0

Note that this .cfg was generated by the FIR filter designer tool. Do not recommend hand crafting a .cfg
file for this many channels. Note some channels in the multichannel.wav file are blank.

HLConolverHost and HLConvolver setup:
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In this case, on the Mac, the input is 16 channel BlackHole. HLConvolver is configured with a 7.1.4 channel
layout. The output is to a 16 channel DAC.

Double click on HLConvolver to bring the UI up:
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While one can load different filters to compare, not only freqeuncy response, but also timing response like
shown in the previous chapter, one can also load different configurations. For example, a 2 channel can be
loaded so that if one wants to listen to stereo music, a click of the filterbank button, one is listening to
stereo. Can also be applied to stereo with two subs, or a 5.1 or 7.1 surround config.

For an example of a 7.1.4 system that uses Digital Room Correction and HLC, see article: Objective and
Subjective Review Of My 7.1.4 Immersive Audiophile System.

https://audiophilestyle.com/ca/immersive/objective-and-subjective-review-of-my-714-immersive-audiophile-system-r1123/
https://audiophilestyle.com/ca/immersive/objective-and-subjective-review-of-my-714-immersive-audiophile-system-r1123/
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Troubleshooting and Operating Tips

This section offers some troubleshooting and operating tips.

1. I entered the license key but HLConvolver did not activate
o Simply close and reopen the application or plugin once or twice to activate.

2. One can click into the GainSlider textbox and Master Trim textbox to enter a dB value directly and hit
enter on Windows and tab out on Mac.

3. To reset the Master Trim level to 0 dB, double click on the rotary slider.

4. To reset any one of the Filterbank gain sliders to 0 dB, double click on slider control or click the
AutoGain button.

5. HLConvolver can work with UPnP and DLNA through supported music players like Audirvana and
JRiver, however, realtime switching of filters may not be possible. In this scenario HLConvolver works
as a "regular" convolver.

6. HLConvolver is not intended to be used as a "convolution reverb" typically used in music production.
While reverb impulse response can be loaded and used, HLConvolver was not intended for this
scenario.

7. If the gain slider remains at 0 dB when a filter has been loaded, then click on the Autogain button to
restore the proper slider setting based on the DC gain of the filter that has been calculated for this
filter.

8. If using HLHost and there is no sound, or static; trace the signal path:
o If you are hearing static and changing the audio buffer size does not fix the issue it typically

means there is a sample rate mismatch somewhere in the audio path. Check all sample rates
from music source to destination DAC to ensure they are the same rate. The exception is if
there is a resampler somewhere in the audio signal path.

o If unable to select an input, check to see that HLHost has been given microphone permissions.
While we are using a digital input, most operating systems still call it a microphone input.

o In HLHost audio settings dialog, there is a level input meter beside the audio input drop down.
If playing music and not seeing the input level meter move means audio is not getting to
HLHost input. Ensure that the OS audio output is input to the virtual audio loopback driver and
the volume has been set at 100%

o If unable to select an output, it may mean that another application has "exclusive" access to
the DAC one is trying to output om. Make sure applications (and servers like Roon) do not
have exclusive access to either the virtual audio loopback driver or the DAC driver.

If there is still an issue, Accurate Sound can provide limited support. Please send the following information:

· Which operating system is being used.
· Which virtual audio loopback driver is being used.
· DAC being used.
· A description of the issue. Screen shots are helpful, a short video from your phone is best.
· The log files.

Thank you.
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Filter won't load: error messages
1. I opened a filter but nothing happened. If you are loading a .cfg file and nothing happens, then it is

most likely a .cfg file syntax error.
o the convolver config file specification: https://convolver.sourceforge.net/config.html is a

"positional" flat file. Typical errors are misspelling of the filepath or filename, often happens
when construction a .cfg file from scratch.

2. I opened a filter, but it did not load and saw the following message flash:

o

o Check to see that it is 32 bit floating point file format. If using a .cfg, check to ensure it is a
valid configuration file.

HLC_Logger
HLC_Logger

HLC_Logger logs are small text files that report any issues or errors. You can find them in the following
locations:

Windows:
C:\Users\<your_user_name>\AppData\Roaming\HLC_Logger\
You may have to “unhide” your AppData folder.

Mac:
/Users/<your_user_name/Library/Logs/HLC_Logger/

Linux and RPi
/home/<your_user_name>/.config/HLC_Logger/
Again, one may need to show "hidden" folders.

Please zip up and send the logs to Accurate Sound if submitting an issue

Won't launch: missing DLL

1. HLConvolver or HLHost won't launch or asking for a runtime DLL
o Download the latest 64 bit Visual Studio C++ redistributable runtime package and install.

Virtual Loopback Driver Clock Synchronization
Generally speaking, using a virtual audio loopback driver on the same computer where the audio interface
is connected can run for hours without any noticeable clock drift (i.e. sounds like crackles or static over
time, sometimes accompanied by a delay in the signal). If and when it occurs, a simple switch of HLHost
sample rate and/or buffer size will reset the audio stream and be stable for hours.

If you are concerned about or experiencing clock drift, then there are solutions available:

On Windows, VB-Audio Matrix provides clock synchronization for all aggregated h/w, virtual audio, and
network audio devices.

If 2 channel operation, for Mac or Windows, a $200 4th gen Focusrite Scarlett 2i2 supports 2 channel
hardware loopback mode. Which means the the I/O stream is under one clock.

https://convolver.sourceforge.net/config.html
https://support.microsoft.com/en-us/topic/the-latest-supported-visual-c-downloads-2647da03-1eea-4433-9aff-95f26a218cc0
https://vb-audio.com/Matrix/
https://us.focusrite.com/products/scarlett-2i2
https://support.focusrite.com/hc/en-gb/articles/13229216604562-Scarlett-4th-Gen-using-Loopback
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If multichannel, network audio solutions using AES67/Ravenna/Dante allows any type of audio routing
scenario on Mac, Windows, and Linux. MAD as an example. There are several other pro audio interfaces
available that provide independent routing of inputs and outputs for stereo or multichannel applications,
Again, under one clock.

Audirvana Studio Mac

In Audirvana Studio on the Mac, there is an issue in the way the AU host works. However, there is a short
workaround. So instead of the procedure here, follow this procedure:
1) HLC is loaded as an effect and real-time control is turned on.
2) Close the properties window and play a song. HLC should now pop to the front.
3) With HLC now at the front, you can now successfully load the filters.
4) When you stop and ready to quit Audirvana, make sure you click the lock icon so HLC window closes
which writes the settings you just made to disk so when you relaunch and press play, all will be there.

Version History Change Log
Version 2.1.5
· Added standalone HLC application with Audio Settings dialog.
· HLC standalone application can run headless.
· Added web interface that can access both HLC standalone application and plugin.
· Added New HLC web server that uses the Open API REST standard for third parties to access HLC

through a web REST API.
· Added instant and performance mode switching capability.

Version 1.2.6
· Added convenience method in HLC to display FIR filter latency in samples or seconds.
· Added convenience method in HLHost to run minimized.

Version 1.2.5
· Additional error handling for loading malformed .cfg files
· Added support for 705600 and 768000 sample rates

Version 1.2.2
· bundling HLHost with HLConvolver

Version 1.2.0
· Added FIR filter latency reporting to GUI and communicate latency to Host application.
· Added "render" mode for DAW's like Logic Pro so when rendering a mix, HLC bypasses the filters so

the digital room correction is not added to the mix.
· Increased the number of channels in HLConvolverHost to handle 64 channels and buffer sizes greater

that 2048 samples.
· Recompile for release on Raspberry Pi.

Version 1.1.0
· Added multichannel operation.
· Added .cfg convolver config file support.
· Added r8brain resampler.
· Recompile for release on Ubuntu.

https://www.merging.com/products/merging_audio_device
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Version 1.0.0
· Initial release - two channel operation
· Run on Windows and Mac
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